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Formats de fichiers

Formats de fichiers
Cette section a pour but de donner une vue simplifiée des différents 
formats de fichiers d’OpenOffice.org.
OpenOffice.org stocke ses fichiers dans un format XML compressé 
(zippé). Ce format est lisible lorsque le fichier est décompressé. Il est 
documenté de manière ouverte et est disponible pour tous. Le format 
OpenDocument bénéficie de la norme ISO 26300.

Remarque Certains  utilitaires  de  compression  vérifient 
uniquement l’extension du fichier, et pourraient ne 
pas  reconnaître  le  fichier  comme  compressé. 
Pour  ouvrir  un  fichier  OpenDocument  avec  ce 
type  d’utilitaire,  il  vous  suffit  de  renommer  le 
fichier avec l’extension .zip. 

À  l’opposé,  les  fichiers  de  Microsoft  Office  sont  stockés  dans  un 
format propriétaire qui n’est pas lisible, et qui n’est pas documenté de 
manière ouverte. Il s’agit de la principale cause de problèmes pour les 
développeurs de logiciels qui conçoivent des filtres pour importer et 
exporter des fichiers au format Microsoft Office.

Tableau  1 : Extensions des fichiers OpenOffice.org (les extensions des  
fichiers des versions OOo 1.1.x sont représentées entre parenthèses).

Type du document Application Extension Équivalent 
MS Office

Traitement de texte Writer odt (sxw) doc

Modèle  de  traitement 
de texte Writer ott (stw) dot

Modèle de document Writer odm (sxg) doc
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Type du document Application Extension Équivalent 
MS Office

Document HTML Writer HTML HTML

Feuille de calcul Calc ods (sxc) xls

Modèle  de  feuille  de 
calcul Calc ots (stc) xlt

Dessin Draw odg (sxd) aucun

Modèle de dessin Draw otg (std) aucun

Présentation Impress odp (sxi) ppt

Modèle de présentation Impress otp (sti) pot

Équations 
mathématiques Math odf (sxm) aucun

Graphiques Graphiques odc aucun

Base de données Base odb mdb
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Formats de fichiers

Remarque OOo peut ouvrir des fichiers MSO. La réciproque 
n’est  pas vraie :  pour  l’instant,  Microsoft  Office 
n’ouvre pas les formats OpenOffice.org.
Si vous avez besoin de transmettre des fichiers à 
un  utilisateur  de  MSO,  commencez  par 
enregistrer  votre  fichier  dans  le  format  natif 
d’OpenOffice.org,  puis  enregistrez  à  nouveau 
votre fichier dans un des formats supportés par 
Microsoft Office. En procédant ainsi, vous aurez 
toujours  votre  original  dans  son  format  natif 
même  s'il  n'est  pas  traduit  parfaitement  aux 
formats de Microsoft Office.
OpenOffice.org  ne  peut  pas  ouvrir  ou  convertir 
directement les fichiers Microsoft Access (.mdb), 
mais  peut  cependant  accéder  aux  données 
contenues  dans  les  tables  en  utilisant  DAO et 
ODBC.  Pour  plus  d’informations,  référez-vous 
aux tutoriels présents à cette adresse :
http://fr.openoffice.org/Documentation/How-
to/indexht-base.html

Conversion en bloc

Pour  utiliser  OpenOffice.org  afin  de  convertir  un  grand  nombre  de 
fichiers,  cliquez  sur  Fichier >  Assistants  >  Convertisseur  de 
documents...
Avant d’effectuer une conversion en bloc de fichiers, assurez-vous que 
cela soit vraiment nécessaire. Lisez ce document jusqu’au bout pour 
avoir une appréciation des limites de ce processus de conversion.
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Remarque Convertir  un  grand  nombre  de  fichiers  peut 
prendre du temps. Il est recommandé de vérifier 
dans  un  premier  temps  votre  espace  disque 
disponible, puis de démarrer la conversion à un 
moment où l’ordinateur ne sera plus utilisé avant 
un certain  temps.  En général,  les  fichiers  OOo 
prennent  moins  de  place  que  les  fichiers 
Microsoft Office, mais par sécurité vous devriez 
allouer autant de place pour les fichiers convertis.

Ouvrir des fichiers

Ouvrir des documents traitement de texte

En plus du format natif OpenDocument (.odt et .ott), OpenOffice.org 
Writer peut importer les formats de traitement de texte suivants :

Microsoft Word 6.0/95/97/2000/XP (.doc, .dot)
Microsoft Word 2003 XML (.xml)
Microsoft Winword 5 (.doc)
StarWriter les formats (.sdw, .sgl, .vor)
AportisDoc (Palm) (.pdb)
Pocket Word (.psw)
OpenOffice.org 1.x (.sxw, .stw)

Document WordPerfect (.wpd)
WPS 2000/Office 1.0 (.wps)
DocBook (.xml)
Ichitaro 8/9/10/11 (.jtd, .jtt)
Hangul WP 97 (.hwp)
.rtf, .txt, .csv

Lors de l’ouverture de fichiers .HTM ou .HTML, OpenOffice.org adapte 
Writer pour travailler sur ces fichiers. 

Ouvrir des feuilles de calcul

En plus du format natif OpenDocument (.ods et .ots), OpenOffice.org 
Calc peut importer les formats de feuille de calcul suivants :

Microsoft Excel 97/2000/XP (.xls, .xlw, .xlt) Rich Text Format (.rtf)
Microsoft Excel 4.x–5/95 (.xls and .xlw, .xlt) Text CSV (.csv et .txt)
Microsoft Excel 2003 XML (.xml) Lotus 1-2-3 (.wk1 and .wk1)
Data Interchange Format (.dif) StarCalc formats (.sdc, .vor)
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Ouvrir des fichiers

dBase (.dbf) SYLK (.slk)
Fichiers .htm et .html incluant Requête page web Pocket Excel (pxl)
Quattro Pro 6.0 (.wb2) OpenOffice.org 1.x (.sxc, .stc)

Ouvrir des présentations

En plus du format natif OpenDocument (.odp et .otp), OpenOffice.org 
Impress 2.3 peut importer les formats de présentation suivants :

Microsoft PowerPoint 97/2000/XP (.ppt, .pps) Computer Graphics Metafile (.cgm)
Modèles Microsoft PowerPoint 97/2000/XP
(.pot)

StarDraw, StarImpress (.sda, .sdd, 
.sdp, .vor)

OpenOffice.org 1.x (.sxi, .sti)

Ouvrir des Documents graphiques

En plus du format natif OpenDocument (.odg et .otg), OpenOffice.org 
Draw peut importer les formats de documents graphiques suivants :

BMP JPEG, JPG PCX PSD SGV WMF
DXF MET PGM RAS SVM XBM
EMF PBM PLT SDA TGA XPM
EPS PCD PNG SDD TIF, TIFF SXD
GIF PCT PPM SGF VOR STD

Ouvrir des documents d’équations mathématiques

En plus des documents d’équations mathématiques, OpenOffice.org 
Math peut ouvrir les fichiers StarMath (.smf) et MathML (.mml)
Lorsque vous ouvrez un document Word contenant un objet « éditeur 
d’équations », sélectionnez la case à cocher [C] pour  MathType vers 
OpenOffice.org Math/OpenOffice.org Math vers MathType dans Outils 
>  Options >  Chargement/Enregistrement >  Microsoft  Office et 
l’objet sera automatiquement converti en objet OpenOffice.org Math.
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Enregistrement des fichiers

Format de fichier par défaut

OpenOffice.org enregistre ses fichiers dans le format OpenDocument 
par défaut. Ce format par défaut peut être modifié, par exemple, si l’on 
veut  toujours enregistrer en fichiers Microsoft Office. Pour modifier le 
format par défaut :

1) Allez dans  Outils > Options >  Chargement/Enregistrement 
> Général (Figure 1)

2) Dans la section Format de fichier par défaut de cette fenêtre, 
choisissez  un  type  de  document (par  exemple  « Document 
texte »)  et  un  format  de  fichier  de  la  liste  Enregistrer 
systématiquement comme.

3) Répéter la manipulation pour chaque type de document 
4) Cliquez sur OK pour enregistrer vos modifications
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Enregistrement des fichiers

Remarque Si  l’option  « Avertir  lorsque  l’enregistrement  est 
réalisé dans un format autre qu’OpenDocument  
ou  le  format  par  défaut »  est  cochée  dans  la 
fenêtre Option > Chargement/enregistrement > 
Général (Figure 11), une boîte de dialogue vous 
avertissant  d’une éventuelle perte  dans la mise 
en  forme  peut  apparaître.  Dans  la  plupart  des 
cas, on ne déplorera aucune perte. Cette option 
pouvant à la longue devenir agaçante, il vous est 
possible de la désactiver.
Le Java Runtime Environment est nécessaire à 
l’exécution des formats pour appareils portables 
tels  que AportisDoc (Palm),  Pocket  Word et 
Pocket Excel. 

Exporter en PDF et en XHTML

Chaque  application  a  la  possibilité  d’exporter  directement  en  PDF 
(Portable Document Format). Ce format standard de compression et 
de visualisation universelles est idéal pour envoyer un fichier devant 
être consulté dans Adobe Reader ou tout autre programme d’affichage 
de PDF, quel que soit le système d’exploitation.
Vous pouvez directement exporter un document au format PDF en 
utilisant  le  bouton  de  la  barre  d’outils  situé  à  gauche  de  l’icône 
Imprimante, ou en choisissant  Fichier > Exporter au format PDF... 
Passer par le menu permet de régler certains paramètres, tels que la 
qualité, la vue initiale ou la sécurité.
Pour  exporter  en  XHTML,  allez  dans  Fichier  >  Exporter... et 
choisissez XHTML dans le menu déroulant Format de fichier.
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Enregistrer des fichiers dans un format différent

Pour enregistrer un fichier dans un format différent, allez dans Fichier 
>  Enregistrer  sous... et  sélectionnez  un  format  dans  la  liste 
déroulante de Type de Fichier (Figure 2).
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Figure  2 :  La  boîte  de  dialogue  Enregistrer  sous d’OpenOffice.org,  où  s’affichent  
certains des formats d'enregistrement disponibles



Enregistrement des fichiers

Formats d'enregistrement possibles avec Writer

En plus de ses formats natifs (.odt et .ott), Writer peut enregistrer dans 
les formats suivants :

OpenOffice.org Writer 1.x (.sxw, .stw)
Microsoft Word 97/2000/XP (.doc)
Microsoft Word 95 (.doc)
Microsoft Word 6.0 (.doc)
Microsoft Word 2003 XML (.xml)
Microsoft Pocket Word (.psw)
DocBook (.xml)
AportisDoc (Palm) (.pdb)
Rich Text Format (.rtf)

StarWriter 5.0 (.sdw)
StarWriter Template (.vor)
StarWriter 4.0 (.sdw)
StarWriter 4.0 Template (.vor)
StarWriter 3.0 (.sdw)
StarWriter Template 3.0 (.vor)
Text (.txt)
Text Encoded (.txt)
HTML (.html, .htm)

Remarque Le  format  .rtf  est  généralement  utilisé  pour 
transférer  des  fichiers  texte  entre  des 
applications, mais des pertes de mise en forme et 
d’images peuvent se produire quand le fichier est 
ouvert dans Microsoft Office. Le meilleur moyen 
d’ouvrir un fichier Writer dans Microsoft Word est 
d’enregistrer ce fichier en format Microsoft Word 
97/2000/XP (.doc).

Formats d'enregistrement possibles avec Calc

En plus de ses  formats natifs (.ods et .ots), Calc peut enregistrer dans 
les formats suivants :

OpenOffice.org Calc 1.x (.sxc, .stc) Data Interchange Format (.dif)

Microsoft Excel 97/2000/XP (.xls, .xlw) dBase (.dbf)

Microsoft Excel 97/2000/XP Template (.xlt) SYLK (.slk)
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Microsoft Excel 95 (.xls, .xlw) Text CSV (.csv; .txt)

Microsoft Pocket Excel (.pxl) Formats StarCalc (.sdc, .vor)

Microsoft Excel 2003 XML (.xml) HTM and HTML files

Formats d'enregistrement possibles avec Impress

En plus de ses formats natifs (.odp et .otp), Impress peut  enregistrer 
dans les formats suivants :

Microsoft PowerPoint 97/2000/XP (.ppt, .pps)

Microsoft PowerPoint 97/2000/XP Template (.pot)

StarDraw, StarImpress (.sda, .sdd, .vor)

Impress peut aussi exporter vers MacroMedia Flash (.swf), ainsi que 
dans  les  différents  formats  de  documents  graphiques  de  Draw 
énumérés ci-dessous.

Formats d'enregistrement possibles avec Draw

Draw ne peut enregistrer que dans ses formats natifs et en format 
StarDraw, mais il peut exporter en :

BMP
EMF
EPS
GIF
JPEG, JPG

MET
PBM
PCT
PGM
PNG

PPM
RAS
SVG
SVM
TIFF

WMF
XPM

Formats d'enregistrement possibles avec l’éditeur 
HTML

Document HTML (.html, .htm)

OpenOffice.org 1.0 Modèle (.stw)

Modèle de document HTML (.oth)
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StarWriter/Web 5.0 et 4.0 Modèle (.vor)

Texte (OpenOffice.org Writer/Web) (.txt)

Texte codé (OpenOffice.org Writer/Web) (.txt)

L'éditeur  HTML peut  également  exporter  un fichier  texte  au format 
MediaWiki. Pour ce faire, allez dans le menu Fichier > Exporter... et 
choisissez MediaWiki.

Les objets OLE (Object Linking and 
Embedding)
Pour changer les paramètres des objets Microsoft Office OLE, utilisez 
le  menu  Outils  >  Options  >  Chargement/enregistrement  > 
Microsoft Office.
Si toutes ces options sont cochées, alors tous les objets inclus seront 
convertis et donc éditables dans les deux suites bureautiques.
Pour les autres types d’objets OLE, cela dépend de la machine sur 
laquelle sont édités les fichiers, comme dans Microsoft  Office. Bien 
sûr,  des  objets  OLE  issus  d’applications  Windows  ne  seront  pas 
éditables  dans  OpenOffice.org  sous  Linux bien  que  les  objets 
s’affichent correctement et puissent être redimensionnés.
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Figure 3 : Modifier les paramètres des objets OLE

Fichiers liés

Sous Microsoft Office il est possible de lier le contenu de plusieurs 
documents en gardant une liaison avec le fichier source. Par exemple 
quand vous copiez des cellules depuis Microsoft Excel, vous pouvez 
les coller sous Microsoft Word. Si sous Word vous faites un  collage 
spécial,  vous  avez  deux  possibilités :  un  coller tout  simple,  avec 
plusieurs options ;  ou un  coller avec liaison,  avec plusieurs options 
également.  Sous OpenOffice.org,  vous ne pouvez pas  copier  avec 
liaison. Par conséquent si sous OpenOffice.org vous ouvrez un fichier 
au format Microsoft  Office contenant une telle liaison, vous perdrez 
cette liaison.
De même, quand un graphique est copié depuis Microsoft Excel avec 
un collage spécial avec liaison dans  Microsoft Word, et que ce fichier 
est ouvert dans Writer, alors le graphique n'apparaîtra pas.
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Fichiers liés

Attention Les liens des fichiers Microsoft Office entre Word 
et Excel sont perdus quand les fichiers Microsoft 
Office sont modifiés avec OpenOffice.org.
Par contre si vous ne faites qu'ouvrir ces fichiers 
sans les modifier, les liens persistent.

WordArt et Fontwork (effets de texte)

Le module d’effets de texte équivalent à WordArt de Microsoft Word 
se  nomme  FontWork  dans  la  suite  OpenOffice.org.  Les  objets 
WordArt  sont  convertis  en objets  Fontwork,  mais  ils  peuvent  alors 
avoir un aspect visuel qui diffère quelque peu.
De même,  les  objets  Fontwork  sont  convertis  automatiquement  en 
objets WordArt quand le document est enregistré au format Microsoft 
Office.

Dessins en mode vectoriel
Les formes vectorielles de base (lignes, flèches, rectangles et ovales) 
sont  toutes  importées  et  exportées  sans  aucun  problème. 
OpenOffice.org offre un degré de contrôle de certaines propriétés plus 
élevé que Microsoft Office, ce qui génère parfois des différences lors 
du passage entre OpenOffice.org et Microsoft Office. Par exemple, la 
taille des flèches et les styles de lignes peuvent varier de l’un à l’autre.
Les  formes  automatiques  de  Microsoft  Office,  telles  les  smileys 
(petites têtes de bonshommes) conservent leurs caractéristiques, par 
exemple la possibilité d’ajuster le degré de sourire ou de grimace de la 
tête.
Microsoft Office offre plus d’options pour les styles d’ombre. Lors de 
l'importation l’aspect peut donc parfois changer. Les styles d’ombre 1, 
2, 5, 6, 14, 17 et 18 sont supportés par OpenOffice.org.
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Les effets 3D sont importés et exportés sans aucun problème, à part 
parfois quelques petites variations dans les angles de rotation.

Trames et cadres texte
Lorsque des trames et des cadres texte issus de Microsoft Office sont 
importés dans OpenOffice.org avec du texte lié, le lien existe toujours, 
mais est souvent mal rendu. Il faut appuyer soi-même sur Entrée pour 
faire passer le texte d'un cadre vers un autre.
En  revanche  l'export  d'OpenOffice.org  Writer  vers  Microsoft  Word 
fonctionne très bien.

Contrôles de formulaires
Les contrôles de formulaires de Microsoft Office, disponibles dans la 
barre d’outils  Formulaire sont  tous importés sans aucun problème. 
Cependant, ces contrôles utilisant des macros, ils seront sans aucune 
utilité, du fait de l’absence de macros construites spécifiquement pour 
OpenOffice.org.

Macros
OpenOffice.org  ne  peut  pas  exécuter  les  macros  Microsoft  Office. 
Bien que les langages des macros soient très semblables, les objets 
sous-jacents sont différents. Pour qu’OpenOffice.org garde les macros 
incluses  dans  les  documents  Word,  Excel  et  PowerPoint  (de  telle 
sorte qu’elles soient toujours disponibles dans  Microsoft Office), il faut 
utiliser  Outils  >  Options  >  Chargement/Enregistrement > 
Propriétés VBA.

Remarque On  ne  court  pratiquement  aucun  risque  en 
ouvrant  dans  OpenOffice.org  un  document 
Microsoft Office infecté par un virus.
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Macros

Cependant, Novell et Sun travaillent conjointement à l'intégration du 
support des macros en VBA de Microsoft Office dans OpenOffice.org. 
Ce support n'est pas encore intégré par défaut car il n'est pas encore 
efficace à 100%. Mais vous avez toujours la possibilité d'utiliser cette 
fonction  en  installant  une  extension,  OOOP-accessories,  que  vous 
trouverez  sur  la  page  du  projet  OxygenOffice  Professional : 
http://sourceforge.net/projects/ooop
Une  autre  version  non  officielle  de  OpenOffice.org  propose  cette 
possibilité directement : http://go-oo.org/
Et  inversement,  les  macros  enregistrées  avec  le  StarBasic 
d'OpenOffice.org ne peuvent être exécutées avec Microsoft Office.

Problèmes d’importation, d’exportation et 
de partage des documents texte

Utilisation correcte des documents 

Il  est  possible  d’éviter  certains  problèmes  en  appliquant  quelques 
règles simples : 

• Utiliser plutôt les styles de caractère et de paragraphe plutôt 
que de mettre en page votre texte manuellement. 

• Utiliser le formatage de paragraphe pour les espaces avant et 
après plutôt que le retour à la ligne, particulièrement pour les 
listes contenant des puces ou des numéros. 

• Utiliser  les  propriétés  d’enchaînement  de  paragraphes  (par 
exemple, garder le style de suite) plutôt que les sauts de page 
manuels. 

• Éviter  d’aligner  le  texte  avec  de  nombreux  espaces  ou 
tabulations,  vous  pouvez  vous  servir  du  formatage  de 
tabulation ou, mieux encore, utiliser la fonction d’alignement 
du texte. 

• N’utiliser que des polices de caractères courantes. 
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Réglages de compatibilité dans OpenOffice.org 
pour le document actif

Les réglages suivants modifient la façon dont OpenOffice.org travaille 
avec  le  document  actif  pour  le  rendre  compatible  avec  Microsoft 
Office. 
Utilisez Outils > Options > OpenOffice.org Writer > Compatibilité 
(Figure 4). 

Ajout d’un espacement de paragraphe et de 
tableau en début de page (document actif) 

Dans Writer, lorsque cette option est décochée, si un paragraphe en 
haut  de  page  (ou  une  colonne)  est  formaté  avec  un  espace  au-
dessus, cet espace est ignoré, alors que dans Word il est inclus. Si 
cette option est cochée, Writer gérera l’espace comme le ferait Word. 
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Problèmes d’importation, d’exportation et de partage des documents texte

Utiliser le formatage de tabulation OpenOffice.org 
1.1

Cette  option indique si  les  paragraphes centrés  et  alignés à droite 
contenant  des tabulations sont  mis  en forme en un bloc centré  ou 
aligné à droite. Si cette case est cochée, seul le texte à droite de la 
dernière  tabulation est  aligné à droite,  alors  que le texte à gauche 
reste tel quel.

Utiliser l’interligne OpenOffice.org 1.1 

Writer  prend  en compte  le  plus  grand des  deux espacements  au-
dessus  et  en  dessous  des  paragraphes ;  Microsoft  Word  fait  la 
somme des deux. Décochez cette option pour que Writer agisse de la 
même façon que Word. 

Caractères et espacement des caractères 

Les  animations  de  texte  sont  importées  par  Writer  sous  l’attribut 
clignotement depuis les fichiers Word. Par exemple « Défilé de tirets 
rouge » devient simplement « clignotement ». 
Dans Word, l’espace entre les caractères en mode normal est plus 
petit que dans Writer. Vous aurez alors souvent l’impression que Word 
peut faire entrer plus de caractères par ligne. Il est également possible 
que l’espacement entre les lignes soit légèrement différent. Le résultat 
final  est  que  les  changements  de  page  se  font  à  des  endroits 
différents du texte. 

Tableaux 

L’auteur n’a pas identifié de problème avec les tableaux. 
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Documents de publipostage 

OpenOffice.org  possède  une  approche  différente  des  sources 
documentaires. Lors de l’importation d’un document Microsoft  Word 
qui  est  le  document  principal  d’un  publipostage,  il  n’y  a  pas  de 
connexion avec les sources documentaires. Il ne suffit pas simplement 
de  créer  cette  connexion,  mais  chaque champ doit  être  inséré  de 
nouveau. Vous pouvez vous référer à la partie  Publipostage dans le 
chapitre 5 intitulé « Différences pratiques entre Writer et Word ». Ou 
pour  plus  de  renseignements,  allez  consulter  les  tutoriels 
d'OpenOffice.org-fr : http://fr.openoffice.org/Documentation/Index.html
Dans Word également, vous pouvez utiliser un autre document Word 
comme  source  documentaire  pour  un  publipostage.  Dans 
OpenOffice.org, il n’est pas possible d’indiquer un document Word (ou 
Writer) comme document source. 
Writer ne possède pas d’option permettant de supprimer les lignes 
vides quand un champ de données est laissé en blanc, vous devez 
utiliser des champs conditionnels. 
Writer fusionne les champs exportés sous forme de texte avec le nom 
du champ entre crochets, par exemple <Nom>. 
Résumé : pour travailler dans un environnement partagé, il faudrait un 
document différent pour chaque « document principal » : un au format 
Word, un autre au format OpenOffice.org. Si vous avez un document 
de publipostage maître au format Word, il serait sûrement plus simple 
de copier le texte dans Writer et d’utiliser l’assistant de publipostage 
de Writer pour recréer le document de publipostage depuis le début. 

Formulaires 

Problèmes rencontrés avec les formulaires créés sous 
Microsoft Office 

Un document verrouillé sous Microsoft  Office ne le sera plus après 
importation dans OpenOffice.org (cette remarque concerne le mode 
création). 
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Les champs de texte de formulaire sont importés dans OpenOffice.org 
comme des champs de saisie et par conséquent perdent leur type. 
Par  exemple,  un  champ de  texte  de  type  « nombre »  ou  « date » 
acceptera  n’importe  quel  texte.  Quand  on  l’utilise  sous 
OpenOffice.org, le champ de texte affiche une boîte de dialogue pour 
entrer le texte. Quand on utilise à nouveau le document sous Microsoft 
Office,  les  champs  de  texte  se  transforment  en  champs 
« Remplissage ». La date et l’heure courantes ainsi que les calculs 
sont importés comme du texte simple.
L’importation et  l’exportation des cases à cocher ne posent pas de 
problème. 
Les menus déroulants sont importés en tant que champs de saisie de 
liste. Comme les champs de texte de formulaire, ils affichent une boîte 
de dialogue dans laquelle l’utilisateur peut choisir une option. Lors de 
l’exportation vers Microsoft  Office,  ils  s’affichent  à nouveau comme 
des menus déroulants. 

Problèmes avec les formulaires créés sous OpenOffice.org 

Les  contrôles  sont  exportés  comme  des  contrôles  actifs  lorsqu’un 
équivalent  existe sous Microsoft  Office.  Comme Word et  Writer  ne 
partagent pas la même base de fonctionnalités et que les macros ne 
sont  pas  compatibles,  il  est  très  difficile  d’avoir  un  formulaire 
fonctionnant  sur  les  deux  plateformes  en  utilisant  des  contrôles 
standards. 
Pour  résumer,  travailler  dans  un  environnement  partagé  avec  des 
formulaires  n’est  pas  chose  aisée,  mais  une  astuce  consisterait  à 
utiliser d’autres champs comme des champs de saisie et des listes de 
saisie.  Pour  ajouter  ces  champs,  utilisez :  Insertion  >  Champ  > 
Autres... > Fonctions. 
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Notes de pied de page, notes de fin d’ouvrage, 
sommaire et index

Les notes de pied de page, les notes de fin d’ouvrage et les index 
s’importent  et  s’exportent  correctement.  Quelques  problèmes  ont 
cependant été rencontrés : 

• L’emplacement des notes de fin d’ouvrage peut varier (dans 
Word, les notes de fin sont placées avant l’index. Dans Writer, 
elles le sont toujours à la fin du document).

• Les entrées bibliographiques de Writer sont transformées en 
texte sous Word. 

• Un index à 3 colonnes exporté de Writer vers Word conserve 
les trois colonnes, mais si l’on repasse de Word à Writer, la 
mise  en  forme  n’est  pas  conservée,  et  l’on  n’obtient  plus 
qu’une seule colonne. 

• Lors  de  l’importation  de  documents  Word  contenant  des 
champs d’entrée d’index,  ceux-ci  sont importés comme des 
champs à la gauche du texte plutôt que comme des champs 
contenant le texte. 

Pour résumer, travailler dans un environnement partagé est possible, 
mais avec quelques petits inconvénients. 

Numérotation des paragraphes, numérotation 
automatique, renvois 

La numérotation des paragraphes, la numérotation automatique ainsi 
que les renvois s’importent et s’exportent sans problème, à l’exception 
des références aux paragraphes numérotés : 

• Les renvois aux numéros des paragraphes numérotés par la 
numérotation automatique ne fonctionnent pas, car Writer ne 
gère pas cette fonction. 

• Writer ne possède pas non plus de fonction de numérotation 
relative dans ses renvois aux nombres. 
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• Le  renvoi  au  numéro  de  chapitre  n’utilise  pas  le  même 
formatage que celui qui est affiché. 

Numérotation des pages 

Une  manière  rapide  et  peu  élégante  sous  Word  pour  ne  pas 
commencer  la  numérotation  des  pages  à  la  toute  première  (afin 
d’obtenir  une  page  de  garde  par  exemple)  et  de  commencer  la 
numérotation par la seconde page consiste à gérer différemment la 
première page et à lui attribuer le chiffre zéro. Malheureusement, lors 
de l’importation dans OpenOffice.org, le numéro de la deuxième page 
sera 2 à la place de 1. Pour régler ce problème dans Writer :

1) Créer un style de page pour la mise en page des pages au-
delà de la première. Le nommer (par exemple) Conversion1. 

2) Placer  votre  curseur  dans  le  premier  paragraphe  de  la 
seconde page. 

3) Aller dans le menu Format > Paragraphe > Enchaînements 
4) Dans  la  partie  Sauts de  la  boîte  de  dialogue  sélectionner 

Insérer. 
5) Cocher la case Avec le style de la page. 
6) Choisisser le style de page créé dans la première étape. 
7) Garder l'option Devant dans Position et sélectionner 1 pour le 

numéro de page. 
Quand vous exporterez ce document sous Word, cela fonctionnera, la 
seule différence étant que le document aura un saut de page en fin de 
première page. Les documents ainsi créés sous Word avec des sauts 
de pages supporteront  sans problème l’importation/exportation avec 
Writer. Il existe une différence avec Word : il y aura une page blanche 
entre la page de garde et la page suivante lors de l’impression (ou de 
l’aperçu avant impression). 
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Lorsque  l’auteur  a  testé  un  document  avec  différents  formats  de 
numérotation  pour  les  pages  paires  et  impaires,  les  numéros  des 
pages impaires étaient importés comme du texte et non comme un 
champ. 
Pour  résumer,  certains  documents  nécessitent  quelques 
manipulations  pour  réparer  la  numérotation  des  pages  après 
importation.  Une fois corrigée, la numérotation des pages pour ces 
documents pourra être importée/exportée sans problème. 

Les champs « date » et « heure » 

Les fonctions de Word CreateDate et SaveDate ne sont pas importées 
sous le même format. Par exemple, si les champs dans le document 
Word sont dans un format qui inclut l’heure, alors ces informations ne 
seront pas toujours affichées par défaut. Pour ajouter l’heure : 
Faites un clic droit sur le champ > Champs , parcourez jusqu’en bas 
le menu déroulant  Formats > Autres formats... , dans le code du 
format ajoutez HH:MM:SS 
Lors de l’exportation les fonctions SaveDate/ DocInformation:Modified 
sont exportées sous forme de texte. 
Les champs de Writer Heure (fixe) et Date (fixe) sont exportés sous 
forme de texte. 

Importer des champs Word

Tableau 2: Conversion des champs Word importés

Champ Word : Conversion dans Writer :

ASK Champ de saisie (Input field) 

AUTHOR DocInformation:Created 

AUTONUM Number Range AutoNr 
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Champ Word : Conversion dans Writer :

AUTONUMLGL Number Range AutoNr 

AUTONUMOUT Number Range AutoNr 

COMMENTS DocInfomation:Comments 

CREATEDATE DocInformation:Created 

DATE Date 

EDITTIME DocInformation:Modified 

FILENAME File name 

FILLIN Input field 

HYPERLINK (comme un lien hypertexte) 

INFO xxx DocInformation:xxx 

KEYWORDS DocInformation:Keywords 

LASTSAVEDBY DocInformation:Modified 

MACROBUTTON (le nom de la macro?) 

MERGEFIELD Mail merge fields (affiché comme le nom du champ) 

MERGEREC Record number 

NEXT Next record 

NOTEREF Show variable 

NUMCHARS Statistics (with select = Characters) 

NUMPAGES Statistics (with select = Pages) 

PAGE Page numbers 

PAGEREF Bookmarks (displayed as name of bookmark) 

REVNUM DocInformation:Document number 

SAVEDATE DocInformation:Modified 

SEQ Number range 

SET Set variable 
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Champ Word : Conversion dans Writer :

SUBJECT DocInformation:Subject 

TEMPLATE Templates 

TIME Date 

TITLE DocInformation:Title 

TOC (Affiche le sommaire) 

Les champs suivants ne sont pas importés dans OpenOffice.org (seul 
le texte qu’ils affichaient lors de la dernière sauvegarde est montré) : 
=,  IF,  DOCPROPERTY,  FILESIZE,  LINK,  LISTNUM,  QUOTE, 
SECTION,  SECTIONPAGES,  STYLEREF,  TOA,  USERADDRESS, 
USERINITIALS, USERNAME. 
Les champs suivants sont ignorés lors de l’importation : AUTOTEXT, 
AUTOTEXTLIST,  BARCODE,  BIDIOUTLINE,  DOCVARIABLE,  EQ, 
GOTOBUTTON,  INCLUDETEXT,  LISTNUM,  MERGESEQ,  PRINT, 
RD, SKIPIF, SYMBOL, TA, TC. 
Le  champ  Word  EDITTIME  correspond  au  champ 
DocInformation:Modified  de  Writer  lors  de  l’importation,  mais  la 
fonction est différente puisqu’il correspond à la date et l’heure de la 
dernière  sauvegarde  et  non  à  la  durée  écoulée  depuis  que  le 
document est ouvert pour y apporter des modifications. 
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Problèmes d’importation, d’exportation et 
de partage des feuilles de calcul

Les champs de formulaires

Les zones de saisie avec menu déroulant, les boîtes de listes et les 
cases à cocher avec des liens vers des cellules de feuilles de calcul 
s’importent et s’exportent toutes correctement, bien qu’en raison du 
traitement  des  polices de caractère,  le  nombre  de lignes affichées 
dans les boîtes de listes puisse varier légèrement. Dans Calc, soit les 
boîtes de listes autorisent la sélection multiple, soit elles ne l’autorisent 
pas,  tandis  que  Microsoft  Excel  permet  deux  modes  de  sélection 
multiple : multiple et étendu. Dans Excel, un lien d’une boîte de liste en 
mode sélection multiple vers une cellule est ignoré (du moins dans 
Excel 2000 ; l’auteur n’a pas vérifié dans Excel XP). Dans Calc le lien 
fonctionne, mais si plus d’un élément est sélectionné, la valeur des 
cellules est fixée à #N/A.
Les boutons radio s’importent dans Calc, mais le lien vers les cellules 
fonctionne différemment. Dans Calc chaque bouton radio a son propre 
lien vers une cellule, déterminant sa valeur comme vraie ou fausse 
selon que l’option est  sélectionnée ou non.  Dans Excel,  le  lien  de 
cellule renvoie le numéro du bouton radio sélectionné. En exportant 
des boutons radio vers Excel, ils perdent le caractère « radio » de leur 
mode de fonctionnement ; en d’autres termes, ils ne sont pas groupés 
de  façon  à  ce  que  sélectionner  l’un  désélectionne  les  autres.  Les 
barres de défilement et les compteurs sont désormais pris en charge 
dans Calc, mais ne peuvent pas encore être importés.
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Fonctions 

Fonctions financières, scientifiques et statistiques

Dans Microsoft  Excel,  certaines fonctions financières acceptent des 
paramètres  de  chaîne  pour  les  dates ;  dans  OpenOffice.org  elles 
exigent  un  numéro  de  série  et  ne  sont  donc  pas  correctement 
importées dans Calc.

Fonctions de l’utilitaire d’analyse ToolPak 

Les  fonctions  fournies  par  ToolPak  pour  Microsoft  Excel  sont 
normalement converties en FONCTION_ADD dans  Calc et renvoient 
les mêmes résultats.

Autres fonctions qui diffèrent

La  fonction  LIREDONNEESTABCROISDYNAMIQUE de  Microsoft 
Excel s'appelle GETPIVOTADATA sous OpenOffice.org Calc.

Pilote de données - Tableaux croisés dynamiques

Les  pilotes  de  données  sont  l’équivalent  pour  Calc  des  tableaux 
croisés dynamiques d’Excel. Il existe cependant un certain nombre de 
restrictions. On peut importer les tableaux croisés dynamiques d’Excel 
dans Calc (bien que les cellules n’acceptent pas la mise en couleur 
des tableaux dynamiques) mais dès que l’on commence à travailler 
avec, ces restrictions deviennent évidentes.
Ces restrictions sont les suivantes :

• Il n’y a pas de rapport de graphique croisé dynamique, mais 
un Pilote de données peut servir de source de données pour 
un graphique.

• L’interface utilisateur autorise un maximum de 8 champs dans 
les  zones  de  données,  de  lignes  ou  de  colonnes.  (Une 
interface alternative qui en autorise davantage est disponible 
ici :  http://homepages.paradise.net.nz/hillview/OOo/ dans  un 
document intitulé MyDataPilot3.ods).
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• Il existe la possibilité de regrouper les données (par exemple, 
regrouper le champ date par semaine ou trimestre, mais pas 
par mois). La solution consiste à créer une nouvelle colonne 
avec une formule pour calculer le regroupement, par exemple 
=Mois().

• On  ne  peut  pas  définir  des  formats  différents  pour  des 
champs différents.

• Calc peut accepter des formules telles que « Différence de » 
ou  « % de »,  mais  ne peut  pas  avoir  ses  propres  champs 
personnalisés  (solution :  créer  de  nouvelles  colonnes  pour 
calculer les valeurs souhaitées).

• Les  options  de  l’API  (interface  de  programmation)  sont 
incomplètes pour écrire des macros qui fonctionnent avec les 
Pilotes de données -- par exemple, la possibilité de décider, 
par l’intermédiaire d’un autre programme comme le langage 
BASIC des macros d’OpenOffice.org, que les tableaux ont des 
totaux généraux ou qu’ils ont accès aux Pilotes de données 
créés à partir de données externes.

AutoFiltre

L’importation et l’exportation d’AutoFiltre se font correctement et les 
lignes  qu’on  désire  masquer  le  sont.  Il  y  a  cependant  un  certain 
nombre de différences entre Microsoft Excel et Calc : 

• Il n’y a qu’un Autofiltre actif  à la fois, pour un document de 
tableur, à moins qu’on utilise des noms de plages de base de 
données.  Les  lignes  restent  cachées,  mais  les  menus 
déroulants de la première ligne disparaissent si l’on applique 
l’AutoFiltre ailleurs. Pour avoir plus d’un AutoFiltre actif  à la 
fois,  définissez  un  nom  de  plage  de  base  de  données 
(Données > Définir la plage) pour les données. Il sera alors 
possible  d’avoir plus d’un AutoFiltre actif  sur une feuille (ce 
qu’Excel ne sait pas faire.)
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• Les  autres  numéros  de  ligne  visibles  ne  changent  pas  de 
couleur pour vous avertir qu’il y a un filtre en place.

• Les  valeurs  erronées  n’apparaissent  pas  parmi  les  options 
des  listes  déroulantes  quand  des  cellules  de  la  colonne 
comportent des erreurs.

• Dans les listes déroulantes,  l’équivalent  du « Personnalisé » 
de Microsoft Excel est appelé « Standard ». 

Diagrammes 

Types de diagrammes proposés dans Excel, mais non dans Calc : 
• Barres de secteur est converti en Secteur Normal
• Secteurs de secteur est converti en Secteur Normal 
• Radar plein est converti en Radar Lignes Seules
• Radar  avec  marquage  des  données  est  converti  en  Toile 

Points  et  Lignes,  mais  dans  le  sens  contraire  des  aiguilles 
d'une  montre  plutôt  que  dans  le  sens  des  aiguilles  d'une 
montre d'Excel

• Bulles sont converties en diagrammes XY Lignes Seules
• Surface 3D est converti en Colonnes 3D Profond Boites

D’autres différences :
1) Les diagrammes sont plus lents à se mettre à jour sous Calc 

que sous Excel.
2) Il  y a moins d’options pour  gérer  les axes de données.  Par 

exemple,  il  n’y  a  pas  d’option  pour  l’inversion  de  l’axe  Y 
(valeurs négatives en haut, positives en bas). 
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Formats des nombres

Il n’y a aucun format  « comptabilité » (avec le symbole monétaire au 
bord gauche de la cellule). Réserver sur la gauche une colonne qui 
contiendrait  le  symbole  monétaire  pourrait  constituer  une  solution 
alternative.

Lignes de grille

Dans Microsoft  Excel,  les  lignes  de  la  grille  sont  une  propriété  de 
chaque  feuille  de  travail  (onglet).  Dans  Calc,  c’est  une  propriété 
générale  du  document  que  vous  pouvez  modifier  grâce  au  menu 
suivant :
Outils > Options > OpenOffice.org Calc > Affichage

Importation, exportation et partage de 
présentations

Dégradés de couleurs et bordures

Impress  ne  gère  pas  certaines  fonctionnalités  de  formatage  de 
Microsoft PowerPoint. Par exemple, les dégradés à trois couleurs, les 
doubles et triples bordures, ou encore les bordures en rond-pointillés 
ne sont pas supportés.
Lors  de  l'importation  de  diapositives  provenant  de  PowerPoint, 
Impress modifie les dégradés à trois  couleurs en dégradés à deux 
couleurs, les doubles et triples bordures en simple bordure, et celles 
en rond-pointillés en tirets ultra-fins.
Pour améliorer le résultat de l’importation, n’hésitez pas à effectuer 
quelques  ajustements  dans  PowerPoint  avant  d’importer  votre 
présentation dans Impress.
Modifier les dégradés de trois couleurs en dégradés de deux couleurs, 
modifier les bordures doubles et triples en bordures simples avec une 
largeur adéquate peut s'avérer pertinent.
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Les bordures de rond-pointillés, transformées en tirets ultra-fins durant 
l’importation, ressemblent de très près au style de PowerPoint et n’ont 
donc pas besoin d’être éditées manuellement.

Multimédia

Les commentaires audio ne sont pas supportés par Impress.
Il  ne  semble  pas  y  avoir  de  réglages  pour  la  personnalisation 
d’animations multimédia, comme la possibilité de jouer un son pour 
les diapos suivantes. 

Animations de diagrammes

Il n’y a aucune fonction d’effet dans les diagrammes comme c’est le 
cas  dans  PowerPoint,  telle  la  présentation  d’une  série  ou  d’une 
catégorie  à  la  suite.  À  l’importation,  les  diagrammes  apparaissent 
simplement. Une façon de contourner cela est d’avoir plusieurs copies 
du diagramme, chacune avec l’affichage désiré.

Package pour CD-ROM

Cette option de Microsoft PowerPoint permet à un fichier PowerPoint 
d’être sauvegardé sur un CD ou tout autre support amovible, ceci en 
assurant  que  tous  les  fichiers  relatifs  y  soient  inclus.  Cette 
fonctionnalité n’est pas incluse dans Impress,  et il n’est pas possible 
d’ouvrir ces fichiers avec Impress.
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Réglage des actions et des interactions

Microsoft PowerPoint permet d'exécuter ces actions à partir d'un clic 
avec la souris ou d'un  pointage avec la souris. Impress ne propose 
ces interactions que lors d'un  clic de souris, et non lors d'un simple 
pointage avec la souris. En conséquence, lors de l'importation d'une 
présentation  PowerPoint  les  actions  pointage  avec  la  souris sont 
transformées en action de  clic  de souris.  L'option qui  permet  sous 
Microsoft PowerPoint de mettre en surbrillance un objet au survol ou 
au clic de la souris n'existe pas sous Impress et sera donc ignorée lors 
de l'importation.

Les animations personnalisées de PowerPoint et les 
effets sur les objets d’Impress

L'application et le rendu des animations personnalisées de Impress 
sont très proches de celles utilisées par Microsoft PowerPoint. Vous 
trouverez  un  tableau  de  noms  d'animations  au  chapitre  7  de  cet 
ouvrage : « Différences pratiques entre Impress et PowerPoint ».

Transitions de Diapos PowerPoint/Impress 

Tout comme pour les animations personnalisées, le nom des effets de 
transition peut varier entre Microsoft PowerPoint et Impress. Pour plus 
de  renseignements,  rendez-vous  au  chapitre  7  de  cet  ouvrage : 
« Différences pratiques entre Impress et PowerPoint ».
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